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Introduction

Introduction
Congratulations on your choice of the state of the art
scanning Pen from WizCom Technologies. WizCom makes
personal, portable scanning Pens that assist with reading,
understanding and utilizing text.
Use the Pen to scan full lines of text, receive word-by-word
translations, and hear scanned words pronounced aloud. Go
to the downloads section on the WizCom website to install
additional one or more of a wide range of dictionaries.
The Pen can also scan and store printed material anytime
and anywhere. Use the Pen to store over 500 pages of
printed text, in a wide range of fonts and sizes, for easy
transfer to a PC. Text can also be scanned directly into any
Windows-based application for ultimate productivity!
This manual is divided into four sections:
1. Getting Started - This section provides basic
information on Pen functions and how to scan, on
installing the USB driver and WizCom Desktop and on
establishing Pen-PC Communications.
2. The Pen - This section demonstrates how to work with
the Pen, including explanations of all the Pen menu
options, applications and different ways of scanning,
inserting and editing text in files.
3. The WizCom Desktop - This section teaches the use
of the PC application used for transferring and
synchronizing data between the Pen and PC.
4. Additional Information - View additional information
such as Pen maintenance information.

Contact and Support Information
Contact us at 888 777 0552 (Toll free in USA and Canada)
or +1 978 727 0026 or email usa.support@wizcomtech.com.
Visit our website http://www.wizcomtech.com to view the
FAQ section and to register your product.
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Getting Started
Familiarizing Yourself with the Pen
The Pen Parts
Your Pen contains the following parts:

Front and Rear Views

Top View

Important: Before using the headphones, please adjust the
volume using the Voice Settings option in the Preferences
menu.
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Setting Up Your Pen
To get started:
1. Remove your Pen from its protective case.
2. Remove the battery compartment cover from the back
of the Pen.
3. Insert 2 AAA batteries into the Pen with the positive and
negative terminals corresponding to the markings on
the sides of the battery compartment.
4. Close the battery compartment.
5. Remove the protective cover from the Pen tip.
to turn the Pen on.
6. Press
7. The Pen is ready to scan!
Note: If you are left-handed, see Right-Left-Handed on
page 49 to change your Pen to left-handed scanning.

Basic Pen Commands
The Pen Keys and their Functions
The keypad contains seven keys for operating your Pen.
Use the keys as follows:

 Power key
 ENT key



: Turn the Pen on and off.
: Access submenus or screens, confirm a
selection or perform an operation.
ESC key
: Navigate backwards, close a screen, or
cancel an operation.
Direction keys
: Scroll through menus and
screens.

Navigating Menus and Lists
To select an item from a menu or a list:
1. Scroll through the menu, using
or
you want is highlighted.
2. Press ENT.

until the item

To select a command key on the display:
1. Use the direction keys to highlight the command key.
2. Press ENT.
To return to a previous menu level from a sub-menu, option
or list, press ESC.
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Scanning Guidelines
Scanning Mode
The Pen is in scanning mode when the red light at the tip of
the Pen is blinking. Scanning mode is disabled when
accessing menus.

Scanning Direction
Text can be scanned from right to left or from left to right.
Both will produce the same results.

Scanning Restrictions
The Pen scans and recognizes printed text in a wide range
of languages, font types and point sizes (6-22 points, up to
8mm) and in a variety of colors on contrasting backgrounds
(except red on white, white on red, blue on black and black
on blue).
It does not recognize handwriting, cursive fonts,
mathematical symbols or other profession-specific signs.

Tips for Good Scanning
To ensure optimum scanning results:
 Hold the Pen at the correct scanning angle.
 Place the scanning material on a flat surface.
 Ensure scanning material is good quality and pages are
not creased. Poorly photocopied materials may provide
bad results.
 Do not scan too fast.

Correct scanning angle of 90°

Poor Character Recognition
Poor character recognition may occur for the following
reasons:
 Low quality scanning material.
 The scanning settings are not set correctly (e.g.
Inverse).
 Holding the Pen at the wrong scanning angle.
 Scanning too fast.
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Learning to Scan (using the Trainer)
This tutorial uses the Notes application and the plastic
scanning Trainer provided with your Pen.
1.

Slide the Trainer onto the tip of the Pen (instead of the
cap) and press into place.

2.

Turn the Pen on. The Pen Main Menu appears. If the
Pen Main Menu does not appear, press ESC until it
is visible on screen.
Scroll to the Notes application using the direction keys
and press ENT.
Scroll down to New File and press ENT.
Scroll down to OK and save the default file name. A
blank screen appears with a blinking cursor.
Position the Pen at a 90° angle and center the
following text between the feet of the trainer. This angle
should be maintained even when scanning without the
trainer.

3.
4.
5.
6.

Use the following practice sentence:

This sentence will help me practice scanning.

7.
8.

Glide the Pen from right to left in a straight line over the
text. Start scanning 1cm from the end of the text and
finish 1cm after the beginning of the text.
The scanned text will appear on the screen. If the text
does not appear correctly on the screen, press ENT to
erase it and scan again.
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Downloading and Installing the Pen
Software
Download the installation software from the internet in order
to install the USB cable and Desktop application needed to
connect your Pen to the PC.
The software can be downloaded from the following location:
http://www.wizcomtech.com/quicktionary2prem/
Use the installation software to:
 Install Product on PC: Install the USB driver and
WizCom Desktop necessary for transferring data
between your Pen and PC.
 Install Add-Ons: Install additional components on
your Pen, such as dictionaries, interface languages,
spellers (for enhanced scanning recognition for specific
languages). The USB driver must be installed (from
Install Product on PC) before you can install any
Add-Ons.

Installing the WizCom Desktop
While the Pen can be used as a stand-alone device,
installing the WizCom Desktop allows you to transfer files
between your Pen and PC. To install the Desktop you will
need your Pen, the USB cable provided with the Pen, and
the installation software downloaded from the internet.
Important: Do not connect the USB cable to your computer
until you have completed the USB driver installation.
To install the Desktop:
1. Download and run the installation software from the
internet. (See Downloading and Installing the Pen
Software above).
2. From the Main Menu click Install Product on PC.
3. Follow the instructions to install first the USB driver and
then the WizCom Desktop.
Note: Please restart your computer if requested to during the
installation procedure.
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Establishing Pen-PC Communications
Do the following to check that your Pen and PC are
configured correctly for Pen-PC Communications:

On the Pen:
To set the Pen communications settings:
1. Turn the Pen on, scroll down to Preferences in the
Pen Main Menu and press ENT.
2. Scroll down to Baud Rate and press ENT.
3. The Baud Rate should be set to 115,200. Scroll down
until you see 115200 on screen and press ENT.
4. Press ESC twice to return to the Pen Main Menu.

On the Desktop:
To view the Desktop application communications settings
select Communications Settings from the Pen
Communications menu on the Menu Bar of the Desktop
application.
The Communications Settings dialog box appears:
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The correct settings (when using the USB cable) should be
as follows:
1. The Port should correspond to the COM port being
used by the Pen. To find out whether the port is correct
do the following:
a. Connect the USB cable to a USB port on your PC.
b. On your computer go to Start/Settings/Control
Panel and select System.
c. Click on the Hardware tab and then click on the
Device Manager.
d. Scroll down to Ports (COM & LPT) and open the
drop-down list of ports.
e. Find the "Prolific USB-to-Serial Comm Port" and
note the corresponding COM port number.

Go back to the Communications Settings dialog
box and modify the Port option accordingly.
2. The Baud Rate should be set to 115,200.
3. Click OK.
f.

Note: If the "Prolific USB-to-Serial Comm Port" is not listed
under Ports (COM & LPT) it means that the USB driver has
not been installed correctly. Rerun the driver installation. If at
any stage you are requested to restart your computer,
please do so.
Once this is complete, run the Communications Wizard to
establish communications between your Pen and the PC.
Make sure you are an administrator on your PC and that the
cable jack is pushed firmly into the Pen (until you hear the
last little “click”).
The Communications Wizard can be accessed from the
Help menu on the Menu Bar of the WizCom Desktop.
If you are experiencing trouble installing the PC software and
establishing communications, see Troubleshooting on page
65.
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The Pen
Main Pen Functions

The Pen Main Menu appears when turning your Pen on for
the first time. Use the direction keys to scroll through the
menu options, and ENT if you wish to enter an application or
access a function or menu. Press ESC to return to the Pen
Main Menu from within any of the options.
The Pen Main Menu contains the following options:

Quicktionary

The Quicktionary application allows you to scan and
translate text. See page 12 for information on installing
additional dictionaries.

Notes

The Notes application enables you to scan printed text into
your Pen. This text can later be transferred to your computer.
See page 26.

Address Book

The Address Book application enables you to scan
business cards and other addresses into your Pen. The
information can be synchronized with your. See page 29.

Internet Links

The Internet Links application enables you to scan
website addresses into your Pen. The links can be sent to
the PC and synchronized with the Favorites folder of Internet
Explorer. See page 33.

Tables

The Tables application enables you to scan information in
table format into your Pen. The tables can be transferred to
the PC and converted to Excel files. See page 37.

Scan to PC

The Scan to PC application enables you to scan text directly
into Windows applications on your PC. See page 40.

QuickLink
Activates the file transfer process, to transfer files between
your Pen and PC. See page 44.
11

The Pen

PC-Controlled Communications
Initiates communications between your Pen and PC so that
you can add and remove Pen components such as
dictionaries and interface languages, or optimize the Pen’s
file system. See page 47.

Preferences
Allows you to change settings on your Pen, such as the
scanning language and the menu type. See page 48.

Information
Displays information about your Pen's current status. See
page 50.

The Quicktionary Application

Use the Quicktionary application to scan and translate text
in various languages. Hear scanned text read aloud from
either the Split Screen or the Dictionary Screen. Access
the Quicktionary from the Pen Main Menu.
You will reach the Input Screen and the red light at the tip
of the Pen will flash. Scan into any screen as long as the red
light is flashing. Scanning is disabled when accessing menus.
If your Pen does not come with a pre-installed dictionary,
you will need to install one before you can start using the
Quicktionary.

Installing Dictionaries
Dictionaries can be installed from the WizCom website from
the following link:
http://www.wizcomtech.com/dictionaries
Click on the dictionary you wish to install and follow the
instructions provided.
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The Quicktionary Screens
The Quicktionary application has three main screens, the
Input Screen, the Split Screen and the Dictionary
Screen. Each screen displays the translation of the selected
words.
You can scan into any screen when the red light at the Pen
tip is blinking. Text on screen will be over-written by the
newly scanned text.

The Input Screen
This is the first screen that appears when you enter the
Quicktionary application. Scan text directly into this screen.
The "Scan in..." message indicates the source language of
the selected dictionary and the highlighted section shows the
input field.

 After scanning, text is displayed in the Split Screen or
the Dictionary Screen.

 Insert text using the Character bar or Opticard. See




Editing and Inserting Text on page 17 for more
information on these options. After inserting text,
select GO to view the translation in the Split Screen or
the Dictionary Screen.
Press ESC to access the Edit Menu while in Edit
Mode.
Press ESC from the Input Screen to access the
Quicktionary Menu.

icon is visible on screen it indicates that the
Note: If the
Quicktionary application is set to scan inverse text (light
text on dark background). To change the setting, see The
Quicktionary Menu on page 15.
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The Split Screen

The Split Screen appears after scanning more than one
word. The scanned text appears on the top of the screen,
and the translation of the highlighted word appears on the
bottom of the screen.








Scroll through the scanned text using the right/left
direction keys. The arrow indicates that scrolling to
the right will reveal the rest of the scanned text.
Scroll through the dictionary entry for the highlighted
word using the up/down direction keys.
Press ENT to view the highlighted word in the
Dictionary Screen.
If the selected dictionary supports reading aloud, use
to scroll to the
icon (voice). Highlight the icon to
hear the scanned text read aloud. Press ENT to hear
the text read aloud again.
Press ESC to return to the Input Screen.

The Dictionary Screen

The Dictionary Screen appears after scanning a single
word, or after selecting a word from the Split Screen.
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If the selected dictionary contains support for reading
aloud, press ENT to hear the word read aloud.

The Pen





Scroll through the dictionary entry using the up/down
direction keys.
Switch between reduced and full dictionary display
using the left/right direction keys.
If you have reached the Dictionary Screen after
selecting a word from the Split Screen, press ESC to
return to the scanned text in the Split Screen.

The Quicktionary Menus
The Quicktionary contains two menus: The Quicktionary
Menu and the Edit Menu.

The Quicktionary Menu

To display the Quicktionary Menu, go to the Input
Screen and press ESC. To return to the Input Screen from
the Quicktionary Menu, press ESC.
Dictionary
The Dictionary submenu contains a series of dictionary
tools.
History
This option displays a chronological list of the most
recently displayed words, with the last word you defined at
the top. The history list can store up to 80 words. Once the
list is full, the oldest word is deleted from the list to make
room for the most recent one.
To select one of these words and view its dictionary entry:
1. Select Dictionary and then select History.
2. Scroll through the list to find the word you want.
Press ENT. The word appears in the Dictionary
Screen.
3. Press ESC to return to the history list.
Adjacent Entries
This option displays a list of all the headwords in the
current dictionary, placing you on the last word you
highlighted, or on the last word you selected from the
history list. If you haven't scanned or selected a word
during the current scanning session, it places you on the
first word in the dictionary. Scroll through the list to find a
different word in order to view its definition.
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1. Select Dictionary and then select Adjacent
Entries.
2. Scroll to the word you want. Press ENT.
3. The word appears in the Dictionary Screen.
4. Press ESC to return to the adjacent entries list.
Select Dictionary
View a list of the dictionaries on the Pen and change the
selected dictionary. This option is only available if there is
more than one dictionary installed on the Pen.
Reset History
Select this option to erase all History entries.
1. Select Dictionary and then select Reset History.
2. The question, "Are you sure?" appears.
3. Select YES to erase the history and return to the
Input Screen.
4. Select NO to return to the Dictionary submenu
without erasing the history.
Preferences
Use this option to modify the default Quicktionary settings.
To accept changes press ENT. To return to the
Preferences submenu without making changes, press ESC.
Toggle settings on or off by pressing ,
or ENT. = on.
 Inverse: Select this option to scan inverse text (white
text on dark background). When inverse text mode is
selected, the red light in the tip of Quicktionary blinks
rapidly and the icon is visible on the Input Screen.
 Reduced Display: This preference determines whether
display elements in the current dictionary, such as
phonetics, appear with the translations. When Reduced
Display is selected, certain display elements are
hidden.
 Auto Speak: When Auto Speak is selected, the
Quicktionary application reads scanned text aloud the
moment you select it for translation.
 Line(s) Per Scroll: This preference determines how
many lines the Quicktionary application scrolls at a
time in the Split Screen and Dictionary Screen. To
or .
change the number of lines per scroll, press
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Help
Guides and Glossaries
This option is present only when the selected dictionary
contains guides or glossaries, such as the Pronunciation
Guide to assist with understanding special symbols used
in the particular dictionary.
About
View copyright and version information for the
Quicktionary application.
Pen Main Menu
Exit Quicktionary and return to the Pen Main Menu.

The Edit Menu
Edit Mode enables editing and inserting of text using the
Character Bar or Opticard. Access the Edit Menu from
the Input Screen by pressing ENT to activate Edit Mode
and then pressing ESC.
The Edit Menu contains three options:
Resume Editing
Return to the current field without making changes. The field
remains in Edit Mode.
Activate Overwrite Mode
Overwrite the existing text. Overwrite mode highlights the
first character after the blinking cursor. Any text that is
inserted overwrites the text starting at the highlighted
character. When Overwrite Mode is activated, the menu
option changes to Activate Insert Mode. Text will be
inserted at the site of the blinking cursor.
Clear Text
Clear the text on screen.

Editing and Inserting Text
To edit or insert text press ENT to activate Edit Mode. The
highlighted field will be replaced by a blinking cursor at the
beginning of the field. To return to regular scanning mode
press ESC twice.
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When the Pen is in Edit Mode, text can be edited or
inserted in two ways:
 Using the Character Bar.
 Using the Opticard.

The Character Bar

Use the Character Bar to manually insert or edit text. The
Character Bar is only available when the Pen is in Edit
Mode. Scroll to the field you wish to edit and press ENT to
activate Edit Mode.
Use the direction keys to scroll to the place you wish to
insert text and press ENT to access the Character Bar.
Press ESC to exit the Character Bar.

Using the Character Bar
The Character Bar works in two modes: Insert Mode and
Overwrite Mode which are determined by the setting in the
application's Edit Menu. The default mode is Insert Mode.



In Insert Mode characters are inserted at the site of
the cursor.
In Overwrite Mode each character that is inserted
replaces the highlighted character.

and
to scroll to the character you wish to insert
Use
and press ENT. Do the same thing for each character you
wish to insert. When you have finished, press ESC to return
to the previous screen.

Character Bar Options
The default Character Bar contains the twenty six lowercase ABC characters as well as the option to access
numbers, punctuation characters, upper-case and accented
characters and symbols.
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Insert Upper-Case Characters
Insert upper case (capital) letters by scrolling to the lowercase character and pressing
to reveal the upper and
lower case options for the character. Scroll to the character
you wish to insert and press ENT.

Insert Accented Characters or Symbols
Insert accented characters or symbols created using
alphabet characters, such as or by scrolling to the
lower-case character and pressing
to reveal the additional
characters available. Scroll to the character you wish to
insert and press ENT.

Insert Numbers
Scroll to this symbol and press ENT to reveal the numeric
Character Bar.

Insert Punctuation Symbols
Scroll to this symbol and press ENT to reveal the
punctuation Character Bar.

Alphabet
Scroll to this symbol and press ENT to return to the default
alphabetic Character Bar.

Delete
Scroll to this option to delete the highlighted character. If you
enter the Character Bar from a field that has reached its
maximum number of characters, the cursor immediately
jumps to the delete symbol and you will be unable to insert
any characters until you delete a character from the field.

Spacebar
Scroll to this option and press ENT to insert a space
between characters.

Multiple Characters Mode
This symbol indicates that you can enter as many characters
as you wish. Scroll to the character you wish to add and
press ENT. Keep adding characters in this way. To exit the
Character Bar press ESC. Scroll to this symbol and press
ENT to change to Single Characters Mode.
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Single Character Mode
This symbol indicates that you can insert one character
before the Character Bar exits. Scroll to this symbol and
press ENT to change to Multiple Characters Mode.

The Opticard

The Opticard is a scanning keyboard found on the back of
the Pen case.
Every letter scanned with the Opticard is identified by its
unique barcode and converted to the correct character on
your Pen.
Use the Opticard to edit scanned text, or to insert text that
cannot be scanned due to scanning limitations. To use the
Opticard:

1. Hold the Pen case horizontally, with the Opticard
facing up and the Opticard title on the right.

2. Scan the Opticard key in the bottom left corner of the
Opticard, from left to right or from right to left, to
activate Opticard Mode. When Opticard Mode is
activated, the light in the tip of the Pen blinks rapidly.

3. Slowly scan the character key, from right to left or from
left to right, or touch the key gently with the tip of your
Pen. The letter appears in the Pen display.
Use the following key combinations to enter the required
characters:
 Lower-Case Characters: Scan the character key.
 Upper-Case Characters: Scan the Shift key and
then scan the character key.
 Caps Lock: To activate/deactivate Caps Lock,
scan Shift twice. Activating Caps Lock enables
you to enter letters in upper case only.
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 Punctuation Symbols: Scan the Ctrl key and
then scan the symbol.

 Accented characters: Scan the Ctrl key, scan the
accent, and then scan the character corresponding
to the accent.
 Accented characters in upper-case: Scan the
Ctrl key followed by the Shift key, scan the accent,
and then scan the character corresponding to the
accent.
 Space: Scan the spc key.
 Delete: Scan the Shift key and then scan the del
key.
4. When you are finished, scan the Opticard key again to
return to normal scanning mode.

The Dictionary Entries
The dictionary entries contain various elements and
indicators. The following examples are taken from the
English to German and German to English dictionaries.
Note: Not all dictionaries contain all the elements mentioned.

Reduced and Full Dictionary Entry Display
Press
or
to toggle the display of the current entry
between reduced and full display. Reduced Display hides
certain display elements such as phonetics. Full Display
shows the entire dictionary entry.
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Scroll Arrows
The scroll arrows on the bottom right of the screen indicate
that you can scroll up and down to view the entire dictionary
entry.
 The hollow arrow indicates the entry is being viewed
in Reduced Display.
 The full arrow indicates the entry is being viewed in
Full Display.

Word List

The Word List sign appears at the top right of the
Dictionary Screen and indicates that there are additional
entries for the headword on screen. Press ESC to view the
Word List.
The Word List appears:
 When the scanned word corresponds to more than one
dictionary entry. For example, if you scan the word
“dressing”, the Quicktionary application enables you to
choose between the dictionary entries “dress” and
“dressing”.
 When the scanned word is a homonym, a word that is
the same as another in spelling but different in
meaning.
 After scanning an idiom or phrasal verb, the
Quicktionary will automatically recognize the entire
phrase from the first word highlighted, and will provide
a Word List containing both the whole idiom and the
first highlighted word.
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Headword

The selected word or a derivative of the selected word, may
consist of more than one word. The screenshots here
display the headword "special" and the word "ate", a
derivative of the headword "eat".

Phonetics

The phonetic transcription of the headword. This can be
seen when the dictionary entries are shown in Full Display.
The guide to the phonetic symbols used in the dictionary, is
available from the Guides and Glossaries menu in Help in
the Quicktionary Menu.

Parts of Speech

Categories of words that describe their particular function,
e.g. nouns, verbs, adjectives. Some dictionary entries
contain several parts of speech, such as "land" which is both
a noun (n.) and a verb (v.).
23
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Idioms

Expressions or phrases usually composed of a sequence of
words. They can be identified:
 Automatically within a sentence
 By scrolling through the translation of the first word of
the sequence.
If you scan text containing an idiom, the Quicktionary
application will automatically display the translation of the
idiom when the first word is highlighted, i.e. the idiom "From
A to Z" displayed from the headword "From".

Split Verbs (German source language)

If you scan a single word which is part of a split verb:
1. The translation will appear along with the Word List
icon. In the Word List, the SPLIT VERB option
appears allowing you to scan the first part of the split
verb.
2. The message “Scan 1st part” will appear allowing you to
scan the first part of the split verb in order to view the
translation of the entire verb.
If you scan a line of text containing a split verb (e.g., in the
German to English dictionary), the Quicktionary
automatically recognizes the verb and combines the parts.
The dictionary entry for the verb is displayed as soon as you
highlight the first part of the verb that appears in the
sentence. For example, if you scan in the sentence "ihr stellt
etwas auf", the dictionary entry for "aufstellen" appears as
soon as you highlight "stellt".
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Compound Words

If you scan a word that is not a dictionary entry, but is a
compound word consisting of existing dictionary entries (e.g.,
in the German to English dictionary), the Quicktionary
separates the compound word into its respective entries.
The translation of the primary word in the compound word
appears first, with the Word List sign next to it.
To display the dictionary entry for another part of the
compound word:
1. Press ENT to go to the Dictionary Screen (if you
scanned more than one word).
2. Press ESC to display the word list.
3. Scroll to the word you want to translate and press ENT.
For example: If you scan the word ‘Sprachgemeinschaft’, the
entry for ‘gemeinschaft’ appears. Go to the word list and
select ‘Sprache’ to view its translation.

Hear Scanned Text Read Aloud
Scanned text can be read aloud from both the Split Screen
and the Dictionary Screen. Adjust the volume using Voice
Settings in the Preferences menu.
Note: Not all dictionaries have text-to-speech functionality.
Access the Auto Speak option from Preferences in the
Quicktionary Menu.
When Auto Speak is selected:
 Scrolling through the text in the Split Screen will
cause the word to be read aloud automatically as it is
highlighted.
 Accessing the Dictionary Screen by either scanning
a single word or from the Split Screen will cause the
word to be read aloud automatically.
When Auto Speak is not selected:
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 Scrolling to the left in the Split Screen until the



icon is highlighted will cause the entire sentence to be
read aloud. Press ENT when the icon is highlighted to
hear the text read aloud again.
Press ENT to hear the word read aloud in the
Dictionary Screen.

Homograph Pronunciation
A homograph is one of two or more words that have the
same spelling but differ in origin, meaning, and sometimes
pronunciation, such as "fair" (pleasing in appearance) and
"fair" (market) or "wind" (wĭnd) and "wind" (wīnd).
If the selected word is a homonym, Quicktionary will read out
all the options for pronouncing the word.

The Notes Application

Use the Notes application to scan printed text, such as
excerpts from journals and books, into your Pen. Access
Notes from the Pen Main Menu.
To create a new note, select New File from the Notes
Menu which opens as soon as you enter the application.
Scan a new file name, or keep the default name.
The scanning screen will appear, with a blinking cursor:

Scan text directly into this screen. The text appears
highlighted. If the scanned text is unclear, erase it by
pressing ENT while it is still highlighted. Otherwise, continue
26
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scanning. The next scans will appear consecutively on
screen.
To insert text at a specific point, move the blinking cursor to
that point using the direction keys. New scanned text will be
inserted at the location of the blinking cursor.
Scroll through the text using the direction keys. Insert a new
paragraph at the end of the text by pressing .

Scanning Language for Notes

Notes uses the default scanning language from Scanning
Language in the Preferences menu. Access the
Preferences menu to change the default scanning
language. Change the scanning language for a specific file
using Select Language in the Edit Menu.

Editing and Inserting Text
In the scanning screen:
 Press ESC to access the Edit Menu.
 Press ENT to access the Character Bar for manual
inserting of text.
 Scan directly into the screen using the Opticard.
For more information on using the Character Bar and
Opticard, see Editing and Inserting Text on page 17.

Transferring Notes Files to the PC
To transfer Notes files to the PC, launch the WizCom
Desktop, connect the USB cable to both Pen and PC and
select QuickLink from the Pen Main Menu. To change the
default file transfer settings, see Change File Transfer
Settings on page 46.

The Notes Menu
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The Notes Menu contains the following options. Select the
option to perform the function described. To return to the
Notes Menu from within a file, press ESC twice.
Edit Current File
The last file you opened is called the current file. Select this
option to open the current file for editing.
New File
Select this option to create a new file. Scan in the file name
and select OK. The scanning screen will appear.
Open File
Open an existing file for viewing or editing.
Delete File
Delete an existing file.
Exit
Exit Notes and return to the Pen Main Menu.
About
View Notes copyright and version information.

The Notes Edit Menu

To access the Edit Menu:
1. Scroll to the file you wish to edit in the Open File menu
from the Notes Menu and press ENT.
2. The file will open on screen. Press ESC to access the
Edit Menu.
The Edit Menu contains the following options:
Resume Editing
Return to the current field without making changes. The field
remains in Edit Mode.
Activate Overwrite Mode
Overwrite the existing text. Overwrite mode highlights the
first character after the blinking cursor. Inserted text
overwrites the text starting at the highlighted character.
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When Overwrite Mode is activated, the menu option
changes to Activate Insert Mode. Text will be inserted at
the site of the blinking cursor.
New Paragraph
Insert a new paragraph after the current one.
Delete Paragraph
Delete the current paragraph.
Select Language
Change the scanning language for the current paragraph.
The scanning language can only be changed if the field is
empty. If the current field contains text it must be erased
before the scanning language can be changed.
The language change will apply to the remainder of the file,
unless the scanning language is changed again.
Scanning Options
Change the scanning setting within the application. These
settings will apply to all future files until the setting is toggles
on or off. Toggle settings on or off by pressing ,
or ENT.
= on.
 Numeric: Select this option to scan numbers only.
When this option is selected regular characters will not
scan correctly and will appear as gibberish text.
 Inverse: Select this option to scan light text on a dark
background.

The Address Book Application

Use the Address Book to store addresses and transfer
them to the PC via the WizCom Desktop. Access the
Address Book from the Pen Main Menu.
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Scanning Language for Addresses
Address Book uses the default scanning language from
Scanning Language in the Preferences menu. Access
Preferences to change the default scanning language.

Editing and Inserting Text into Address
Book Fields
To edit or insert text into a specific field scroll to the field and
press ENT to activate Edit Mode. The highlighted field will
be replaced by regular text, with a blinking cursor at the
beginning of the field. To return to regular scanning mode
press ESC twice.
When the Pen is in Edit Mode, text can be edited or
inserted in two ways.
1. Using the Character Bar.
2. Using the Opticard.
For more information on using the Character Bar and
Opticard, see Editing and Inserting Text on page 17.

Transferring Addresses to the PC
To transfer addresses to the PC, launch the WizCom
Desktop, connect the USB cable to both Pen and PC and
select QuickLink from the Pen Main Menu. To change the
default file transfer settings, see Change File Transfer
Settings on page 46.

The Address Book Menu

The Address Book Menu contains the following options.
Select the option to perform the function described:
New Address
Create a new address.
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1. Scan the address details into the appropriate fields.
After scanning, the cursor will jump automatically to the
next field.
2. Select OK.
View Addresses
View saved addresses. Scroll through addresses using the
direction keys. When an address is highlighted:
1. Press ENT to view the full entry. Press ENT again to
open the address for editing.
2. Press
to access the Addresses Menu.
Use the Addresses Menu to do the following:
1. Find Address
2. Select Search Language
3. Delete Address
4. View Address
5. Edit Address
Settings
Change the default settings for new addresses. Toggle
settings on or off by pressing ,
or ENT. = on.
 Scroll Screen: When Scroll Screen is selected, the
screen will scroll (rather than jump) to the next field
after text is scanned.
 Auto Advance: When Auto Advance is selected, the
screen will move automatically to the next field after
text is scanned.
 AutoName: When AutoName is selected, scan both
the first name and last name at the same time, and the
scanned text will automatically be sent to the First
Name and Last Name fields.
 Next Address Lang.: Change the scanning language
for the next address you scan.
 Select Fields: Select the fields you wish to use for
storing address information.
 Field Settings: See a list of the fields available for
storing address information.
New File
Address Book uses a file called "mainadd" to store all
scanned addresses. This file is the only file that is
synchronized with the PC when using the QuickLink
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function. You can create new files to organize addresses,
but these files will not be transferred to the PC.
Open File
Open an existing file for storing addresses.
Delete File
Delete an existing file. If you delete the current file you must
open another file before you can continue scanning.
Note: you can't delete the file, "mainadd" from the Pen.
Exit
Exit the Address Book application.
About
View Address Book copyright and version information.

The Address Book Edit Menu

Scroll to the field you wish to edit, press ENT to activate Edit
Mode and ESC to access the Edit Menu. The Edit Menu
contains the following options. Select the option to perform
the function described:
Resume Editing
Return to the current field without making changes. The field
remains in Edit Mode.
Activate Overwrite Mode
Overwrite the existing text. Overwrite mode highlights the
first character after the blinking cursor. Inserted text
overwrites the text starting at the highlighted character.
When Overwrite Mode is activated, the menu option
changes to Activate Insert Mode. Text is inserted at the
site of the blinking cursor.
Insert Line
Insert an extra line into the current field.
Delete Line
Delete a line from the current field. If there is only one line,
the text in the field will be deleted.
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Clear Line
Delete the text in the current field.
Scanning Options
to access
Change the settings for the current field. Press
this menu during scanning. Toggle settings on or off by
pressing ,
or ENT. = on.
 Numeric: Select this option to scan numbers only.
When this option is selected regular characters will not
scan correctly and will appear as gibberish text.
 Inverse: Select this option to scan light text on a dark
background.
 Multiple Lines: Select this option to scan multiple
lines into the current field.

The Internet Links Application

Use Internet Links to store web addresses (URLs) and
transfer them to the PC via the WizCom Desktop. Access
Internet Links from the Pen Main Menu.

Scanning Language for Links Files
Internet Links uses the default scanning language from
Scanning Language in the Preferences menu. Access the
Preferences menu to change the default scanning
language.

Editing and Inserting Text into Internet
Links Fields
To edit or insert text into a specific field scroll to the field and
press ENT to activate Edit Mode. The highlighted field will
be replaced by regular text, with a blinking cursor at the
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beginning of the field. To return to regular scanning mode
press ESC twice.
When the Pen is in Edit Mode, text can be edited or
inserted in two ways.
1. Using the Character Bar.
2. Using the Opticard.
For more information on using the Character Bar and
Opticard, see Editing and Inserting Text on page 17.

Transferring Internet Links to the PC
To transfer links to the PC, launch the WizCom Desktop,
connect the USB cable to both Pen and PC and select
QuickLink from the Pen Main Menu. To change the
default file transfer settings, see Change File Transfer
Settings on page 46.

The Internet Links Menu

The Internet Links Menu contains the following options.
Select the option to perform the function described:
New Link
Create a new internet link.
1. Scan the website address (English only) into the
Internet Link field. When you finish, the cursor will
jump automatically to the next field.
2. Scan a description for the link into the Description
field and select OK.
View Links
View saved links. Scroll using the up/down direction keys.
When a link is highlighted:
1. Press ENT to view the full entry. Press ENT again to
open the link for editing.
to access the Links Menu.
2. Press
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Use the Links Menu to do the following:
1. Delete Link
2. View Link
3. Edit Link
Settings
Change the default settings for new links. Toggle settings on
or off by pressing ,
or ENT. = on.
 Scroll Screen: When Scroll Screen is selected, the
screen will scroll (rather than jump) to the next field
after text is scanned.
 Auto Advance: When Auto Advance is selected, the
screen will move automatically to the next field after
text is scanned.
 AutoDescribe: When AutoDescribe is selected, the
description for the new link is taken automatically from
the Internet Link field.
 Next Link Language: Change the scanning language
for the Description field of the next link you scan.
New File
Internet Links uses a file called "mainlnk" to store all
scanned links. This default file is the only file that is
transferred to the PC when using the QuickLink function.
You can create new files to organize links, but these files will
not be transferred to the PC.
Open File
If you have created new links files you can access them
using this option. Scroll through the files and select the one
you wish to use to store future links.
Delete File
Use this option to delete any links files you may have
created. If you delete the current file you must open another
file before you can continue scanning.
Note: you can't delete the main links file, "mainlnk" from the
Pen.
Exit
Exit the Internet Links application.
About
View Internet Links copyright and version information.
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The Internet Links Edit Menu

To access the Edit Menu, scroll to the field you wish to edit,
press ENT to activate Edit Mode and ESC to reach the Edit
Menu. The Edit Menu contains the following options.
Select the option to perform the function described:
Resume Editing
Return to the current field without making changes. The field
remains in Edit Mode.
Activate Overwrite Mode
Overwrite the existing text. Overwrite mode highlights the
first character after the blinking cursor. Any text that is
inserted overwrites the text starting at the highlighted
character.
When Overwrite Mode is activated, the menu option
changes to Activate Insert Mode. Text will be inserted at
the site of the blinking cursor.
Insert Line
Insert an extra line into the current field.
Delete Line
Delete a line from the current field. If there is only line, the
text in the field will be deleted.
Clear Line
Delete the text in the current field.
Scanning Options
Change the settings for the current field. This setting can
also be accessed during regular scanning by pressing .
Toggle settings on or off by pressing ,
or ENT. = on.
 Numeric: Select this option to scan numbers only.
When this option is selected regular characters will not
scan correctly and will appear as gibberish text.
 Inverse: Select this option to scan light text on a dark
background.
 Multiple Lines: Select this option if you wish to scan
multiple lines into the current field.
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The Tables Application

Use Tables to store information in tabular form and transfer
it to the PC via the WizCom Desktop. Access Tables from
the Pen Main Menu.

Scanning Language for Tables Files
Tables uses the default scanning language from Scanning
Language in the Preferences menu. Access Preferences
to change the default scanning language.

Editing and Inserting Text into Tables
Cells
To edit or insert text into a specific cell scroll to the cell and
press ENT to activate Edit Mode. The highlighted field will
be replaced by regular text, with a blinking cursor at the
beginning of the field. To return to regular scanning mode
press ESC twice.
When the Pen is in Edit Mode, text can be edited or
inserted in two ways.
1. Using the Character Bar.
2. Using the Opticard.
For more information on using the Character Bar and
Opticard, see Editing and Inserting Text on page 17.

Transferring Tables to the PC
To transfer Tables files to the PC, launch the WizCom
Desktop, connect the USB cable to both Pen and PC and
select QuickLink from the Pen Main Menu. To change the
default file transfer settings, see Change File Transfer
Settings on page 46.
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The Tables Menu

The Tables Menu contains the following options. Select the
option to perform the function described:
Edit Current File
The last file you opened is called the current file. Select this
option to open the current file for editing.
Settings
Change the default settings for new Tables files. Toggle
settings on or off by pressing ,
or ENT. = on.
 Scroll Screen: When Scroll Screen is selected, the
screen will scroll (rather than jump) to the next field
after text is scanned.
 Auto Advance: When Auto Advance is selected, the
screen will move automatically to the next field after
text is scanned.
New File
Select this option to create a new file. Scan in the file name
and select OK. The tables screen will appear. The Tables
application starts at A1, the cell at the upper left-hand corner
of the table.
Open File
Open an existing file for viewing or editing.
Delete File
Delete an existing file.
Exit
Exit the Tables application.
About
View copyright and version information for the Tables
application.
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The Tables Edit Menu

Scroll to the field you wish to edit, press ENT to activate Edit
Mode and ESC to reach the Edit Menu. The Tables Edit
Menu contains the following options. Select the option to
perform the function described:
Resume Editing
Return to the current cell without making changes. The cell
remains in Edit Mode.
Activate Overwrite Mode
Overwrite the existing text. Overwrite mode highlights the
first character after the blinking cursor. Any text that is
inserted overwrites the text starting at the highlighted
character. When Overwrite Mode is activated, the menu
option changes to Activate Insert Mode. Text will be
inserted at the site of the blinking cursor.
Clear Line
Delete the text in the current cell.
Select Language
Change the scanning language for the current cell. The
scanning language can only be changed if the cell is empty.
If the current cell contains text it must be erased before the
scanning language can be changed. The scanning language
will only change for the current cell.
Scanning Options
Change the settings for the current cell. Toggle settings on
or off by pressing ,
or ENT.
= on.
 Numeric: Select this option to scan numbers only.
When this option is selected regular characters will not
scan correctly and will appear as gibberish text.
 Inverse: Select this option to scan light text on a dark
background.
 Multiple Lines: Select this option if you wish to scan
multiple lines into the current field.
39

The Pen

Insert Row
Insert a row into the table. The row will be inserted below the
row containing the current cell.
Insert Column
Insert a column into the table. The column will be inserted
after the column containing the current cell.
Remove Row
Delete the row containing the current cell.
Remove Column
Remove the row containing the current cell.
Insert Line
Insert a line into the current cell.
Delete Line
Delete a line from the current cell. If there is only one line in
the current cell, the text in the current cell will be deleted.

The Scan to PC Application

Use Scan to PC to scan text and send it directly to the PC.
Text can be scanned into any file or application on the PC
that has a blinking cursor. Access the Scan to PC
application by selecting it from the Pen Main Menu.
Scan to PC works in the same way as standard editing
using a keyboard i.e., highlighted text is overwritten, text is
inserted in Insert Mode or overwritten in Overwrite Mode.
Using Scan to PC does not interfere with your regular use of
the Windows application.
To use Scan to PC, the WizCom Desktop must be running
on the PC. If there is no Scan to PC compatible application
open on screen, the text will still be sent from the Pen, but
will not be accessible on the PC. The WizCom Desktop
does not need to be maximized on screen as long as it is
40

The Pen

running (the
icon appears in the notification area of the
Windows taskbar).
To use Scan to PC:
1.
2.
3.

4.
5.

Launch the WizCom Desktop.
Make sure that the Pen is connected to the PC with the
USB cable.
Ensure that communications are working between your
Pen and computer. If you are not sure if your
communications are working, run the
Communications Wizard from the Help menu on the
WizCom Desktop Menu Bar.
Note: If you have problems with Pen-PC
Communications, see Establishing Pen-PC
Communications on page 9.
On your Pen, select Scan to PC from the Pen Main
Menu. The application opens in the scanning screen so
you can start scanning immediately.
When you have finished scanning, press ESC on the
Pen to exit Scan to PC.

Note: Scan to PC works in most Windows applications,
however, it may be incompatible with some applications.

Scan to PC Modes
Scan to PC has two scanning modes: Send Immediately
and Deferred Sending.
Send Immediately
When the Send Immediately option in the Scan to PC
Settings menu is selected , any text that is scanned is sent
directly into an open file on the PC that has a blinking cursor.
This is the default scanning mode.
Deferred Sending
When the Send Immediately option in the Scan to PC
Settings menu is not selected , text that is scanned is
shown on the screen, and the user can choose whether to
send the text on screen to the PC or to discard it or rescan it.
 To send the text on screen press ENT.
 To scan multiple lines, scan a line of text and then
press
to store the scanned text and keep scanning.
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Press
every time you want to save a line. When you
have finished scanning press ENT to send the scanned
text to the PC.

Scan to PC Settings on the Pen
Entering the Scan to PC application takes you directly to the
scanning screen. Select the Settings menu from the
scanning screen to switch between the Scan to PC modes,
and to modify scanning options.
The Settings menu contains the following options:
Send Immediately
Select this option for scanned text to be sent directly to the
PC after scanning. Toggle Send Immediately on or off by
pressing ,
or ENT. = on.
Scanning Options
Change the default settings for the application. Toggle
settings on or off by pressing ,
or ENT. = on.
 Numeric: Select this option to scan numbers only.
When this option is selected regular characters will not
scan correctly and will appear as gibberish text.
 Inverse: Select this option to scan light text on a dark
background.
About
View copyright and version information for the Scan to PC
application.

Scan to PC Settings in the WizCom
Desktop
Use the Scan to PC Settings in the WizCom Desktop to
determine what key is inserted after each line of text is sent
to the PC application. The default setting is Space, meaning
that a space is inserted after each scan appears in the
application.
Access Scan to PC Settings from the Pen
Communications menu on the WizCom Desktop Menu
Bar.
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From the Scan to PC Settings menu define the key you
want to enter after each scan:
 Space: Inserts a space after each scan.
 Tab: Inserts a tab after each scan. (For instance, when
scanning into an Excel table, when you finish scanning
the cursor jumps automatically to the next cell.)
 Enter: The cursor moves to the next line after each
scan.
 Nothing: Nothing is inserted after each scan; the next
scanned text will be inserted immediately after the last
character of the previous scan.

Scanning in Different Languages
Scan to PC uses the default scanning language from
Scanning Language in the Preferences menu. Access
Preferences to change the default scanning language.
If you are scanning in languages other than English, your
Windows settings (non-unicode programs option) must be
configured to fully support the language you wish to use. If
the version of Windows you are using does not support the
character set of the language you have selected, you will not
be able to view the character set correctly. Language
settings can be accessed through the Windows Control
Panel settings (name of application varies depending on
which operating system you are running).
The keyboard corresponding to the scanning language you
require should be installed and should be active in the
Windows application you wish to scan into. The WizCom
Desktop language bar should be set to the required
language.
To confirm that the language settings are correct in the
Windows application, open the application you wish to scan
text into and attempt to type text in the required language. If
it appears correctly, the Windows application is ready.
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QuickLink

Use the QuickLink option in the Pen Main Menu to
transfer files from your Pen to the PC using the Desktop
application. This function transfers files from the Notes,
Address Book, Internet Links and Tables applications.
To use QuickLink, the WizCom Desktop must be running
on the PC. The WizCom Desktop does not need to be
icon
maximized on screen as long as it is running (the
appears in the notification area of the Windows taskbar).
Before using QuickLink on the Pen, make sure to modify
the default settings in the WizCom Desktop by accessing
the File Transfer Settings option from the Pen
Communications menu in the Menu Bar.
To transfer files using QuickLink do the following:
1. Connect the USB cable to both the Pen and the PC.
2. Make sure that Pen communications are set to On in
the Desktop and that communications have been
established (see Establishing Pen-PC
Communications on page 9).
3. On your Pen, scroll down to the QuickLink option in
the Pen Main Menu and press ENT.
4. A dialog box will open showing the file transfer process.
5. The success message will appear when the file transfer
process has completed.

File Transfer Settings in the WizCom
Desktop
Use the File Transfer Settings dialog box to determine
what happens to files saved on the Pen when you select the
QuickLink option from the Pen Main Menu.
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If you have several Pens using the same Desktop
application, you can define individual settings for each Pen,
based on their individual Pen names.

To define File Transfer Settings:
1. Select File Transfer Settings from the Pen
Communications menu on the Menu Bar of the
Desktop to reveal the File Transfer Settings menu.
2. Make sure that the Pen name shown is the same as the
Pen you are using. If not, select the correct Pen name
from the drop-down list.
3. To select the file transfer function for each application,
either double-click on the application name in the table,
or click on the application name and then click the
Change button. The Change File Transfer Settings
menu will appear. It displays the options available for
the specific application. See below for more information.
4. Select the option you wish to use and click OK. Repeat
for each application.
5. If you want the File Transfer Settings dialog box to
appear before each QuickLink operation (to verify the
settings), click on the Show this Dialog before each
File Transfer checkbox prior to closing the dialog box.
6. When you have finished, close the File Transfer
Settings menu by clicking on the Close button.
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Change File Transfer Settings
There are four options available when defining File
Transfer Settings. Not all are available for all applications.
1. Synchronize Pen and PC: The records on the Pen
and computer are synchronized, resulting in identical
data files on the Pen and the computer. If the same
record was changed on both the Pen and computer,
the original records disappear and two new records
are created. To erase files from the Pen after
synchronizing check the Flush option.
2. Pen to PC: The Pen files are copied from the Pen to
the computer, overwriting the corresponding files on
the computer. To erase files from the Pen after
synchronizing check the Flush option.
3. PC to Pen: If you are interacting with host applications,
the data in the host application file overwrites the data
both in the Desktop and on the Pen. If you are not set
to transfer files with host applications, the files on the
Desktop are copied to the Pen, overwriting the
corresponding files on the Pen.
4. Don’t transfer the files of this application: No
files are transferred between the Pen and computer for
the specified application; the files remain untouched
on both the Pen and computer.

Synchronize with Host Applications
If you want your files to be saved in Microsoft Office
compatible formats you must activate the Host Settings
function in the File Transfer Settings menu.
1. Select File Transfer Settings from the Pen
Communications menu on the Menu Bar of the
Desktop. The File Transfer Settings menu appears.
2. Check the option This Pen Name will transfer files
with host applications.
Note: Only one Pen can be associated with host
applications. If the checkbox is disabled it means
another Pen has already been selected to interact with
these applications. If you wish to change it, go through
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3.
4.

5.

the list of Pen names, find the one where the option is
checked and deselect it.
Click on the Host Settings button (now enabled).
Look at the information for each application in the
Host Application column. Click on the line for each
application and a drop-down menu will appear.
Select the option you wish to activate for each
application.

PC-Controlled Communications

Use PC-Controlled Communications only when directed
to by the WizCom Desktop or the product installation
software. It is accessed from the Pen Main Menu.
This option is used by the Desktop to optimize the Pen file
system, to check Pen-PC Communications using the
Communications Wizard and to launch the Add\Remove
Pen Components dialog.
It is used to install Add-Ons, including spellers, interface
languages and dictionaries.
When directed, select PC-Controlled Communications
from the Pen Main Menu. Scroll down to the option and
press ENT. The following screen shows that the Pen is
ready to communicate.

See Establishing Pen-PC Communications on page 9 to
ensure that your Pen and PC are set up correctly for
communication.
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The Preferences Menu

Modify the default Pen settings using this menu which can
be accessed via the Pen Main Menu. To select an option,
or
and press ENT
scroll to the required option using
when the option is highlighted. To return to the previous
screen without making changes, press ESC.
The Preferences menu contains the following options:
Scanning Language
Use this option to change the default scanning language.
1. Select Scanning Language.
2. Scroll to the required language and press ENT.
Note: The scanning language should be set to the same
language as the text you are scanning. Spellers can be
added (from the product installation software) to enhance
character recognition in supported languages.
Interface Language
Use this option to change the language in which menus and
messages appear. Interface languages can be added to the
Pen using the product installation software.
1. Select Interface Language.
or
2. Scroll to the interface language you want, using
and press ENT.
Communications Settings
Use this option to adjust the settings communications
between your Pen and computer.
Connection Device
The USB cable is used for Pen-PC Communications.
Baud Rate
The Baud Rate should always be set to 115,200.
1. Select Baud Rate.
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2.

If the Baud Rate is not on 115,200, scroll down
using
until it is visible on screen and press ENT.

Voice Settings
Use this option to adjust the voice settings on the Pen. This
changes the way text is read aloud in the Quicktionary
application.
Volume
Use this option to adjust the volume level of the speaker.
1. Select Volume. The adjustment bar appears.
2. Adjust the volume level to the setting you want using
or
and press ENT.
Pitch
When auto speak is selected, the Pen automatically
pronounces the word you select or highlight.
1. Select Pitch.
or
and press ENT.
2. Adjust the pitch using
Reading Speed
This option enables you to adjust the speed at which the
Pen pronounces words.
1. Select Reading Speed.
or
and press
2. Adjust the reading speed using
ENT. The higher the number, the faster the speed.
Auto Shut-Off Time
If the Pen is not in use it will shut down automatically after
two minutes. Use this option to change the automatic shutoff time.
1. Select Auto Shut-Off Time.
or
2. Choose the auto shut-off time you want using
and press ENT.
Right-/Left- Handed
Use this option to switch between right and left handed
modes. Switching between these modes rotates the text on
the display 180°.
1. Select Right-/Left- Handed.
or
and press
2. Scroll to the mode you prefer using
ENT.
Menu Type
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Use this option to define whether your Pen menus appear as
text only, icons only, or both text and icons.
1. Select Menu Type.
2. Scroll to the menu type you prefer using
or
and
press ENT.
Long-Press Interval
Use this option to adjust the amount of time you need to
keep a button pressed for a long press.
1. Select Long-Press Interval. The adjustment bar
appears.
or .
2. Move the slider to the setting you want using
3. Test the setting by pressing and briefly holding down
the
key. If the screen flashes the setting is fine. If the
display does not flash, either adjust the setting to a
shorter press, or press longer.
Double-Click Interval
Use this option to adjust the amount of time between the two
clicks for a double click.
1. Select Double-Click Interval. The adjustment bar
appears.
2. Move the slider to the setting you want using
or .
3. Test the setting by double clicking the
key. If the
screen flashes the setting is fine. If the display does not
flash, either adjust the setting to a shorter press, or
double click faster.
Contrast
Use this option to adjust the brightness of the display.
1. Select Set Contrast; the adjustment bar appears.
or
and press ENT. The
2. Adjust the contrast using
higher the number, the darker the display.

The Information Menu
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The Information menu displays the following Pen
information:
Memory Status
See how much memory is left on the Pen's extension card.
This option is useful if you wish to know if your Pen contains
enough free memory to install extra components such as
dictionaries.
Compact Memory
Maximize free space on the Pen's extension card by
compacting components already on the Pen.
Battery Status
Check how much power is left in the batteries. A diagram
displays the power level.
Serial Number
View the Pen’s serial number.
About
View Pen version number, copyright information and version
number of the Pen operating system.
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The WizCom Desktop
The WizCom Desktop is the application your Pen uses to
communicate with and transfer data to your PC. It has two
main functions:
1. Transferring stored data from the Pen to the PC using
the QuickLink option on the Pen.
2. Scanning data directly into Windows applications using
Scan to PC.
You can also use the Desktop to view and edit the text sent
from the Pen to the PC, convert sent files to other formats,
modify Pen components and optimize Pen performance by
compacting the Pen file system.

Running the Desktop
If, during installation, you selected the option for the Desktop
to run upon Window's start-up, the Desktop will automatically
start running when you start your computer. To open the
in the notification
Desktop window, click the Desktop icon
area of the Windows taskbar and select the Show Window
option from the pop-up menu.
If the Desktop application does not run when you start up
your computer, or if you closed the application, you can start
it by opening the Windows Start menu and selecting
Programs\WizCom Desktop\WizCom Desktop.

Exiting the Desktop
To exit the Desktop, select Exit from the File menu. Or click
the Desktop icon, then select Exit.
in the
Pressing ALT+F4 on the keyboard or clicking
upper-right corner of the Desktop window closes the
Desktop window, but does not close the Desktop application.
The application continues to run in the background, and the
Desktop icon remains in the notification area of the Windows
taskbar.
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The Desktop User Interface
The Desktop is divided into three main sections:
1. Menu Bar: The Menu Bar runs across the top of the
screen. It contains all the options for using the Desktop.
2. Toolbar: The Toolbar is an iconic interface containing
some of the main Desktop features.
3. Desktop Window: The Desktop Window is where
all the files transferred between the Pen and PC can be
viewed and edited.

The Menu Bar
The Menu Bar runs across the top of the screen. It contains
four menus.

To select an option, click on the menu and then click on the
option in the drop-down list. Some menus can be activated
using shortcut-key commands which are shown on the right
of the menu option. Press the key sequence shown to
execute the shortcut-key command.

The File Menu
The File Menu contains the following options:
 New: Create a new file.
 Open: Open an existing file.
 Save As: Save an existing file in a different location/
format.
 Pen Names: Add, rename or delete Pen Names.
 Find: Search for words in the current file.
 Print: Print the current file.
 Exit: Exit the Desktop. Note: Selecting
the application to the Windows Taskbar.

will minimize

The Pen Communications Menu
The Pen Communications Menu contains the following
options:
 Turn Pen Communications Off/On: Toggle
communications on and off.
 Add/Remove Pen Components: Advanced users
only! Should only be accessed if advised by Support.
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 Optimize Pen File System: Clear empty spaces on
your Pen extension card caused by file transfer and
deletion.
 Communications Settings: Define communication
settings for Pen-PC communications.
 File Transfer Settings: Define the settings for Pen-PC
file transfer.
 Scan to PC Settings: Choose the key you wish to
insert after each line of text is sent to the PC. The
default setting is Space.

The View Menu
The View Menu contains the following options:
 Log: View the history of the last three file transfer
sessions.
 Interface Language: Change the language in which
menus and messages appear in the Desktop.
 Text Size: Change the text size in the Files and
Current Files Panes.
 Toolbar: Hide or show the Toolbar, which contains
icons for accessing some of the main Desktop functions.
 Status Bar: Hide or show the Status Bar at the
bottom of the screen which provides information about
the current status of the application files you are viewing
in the Desktop application.
 Applications: The applications shown in the View
menu vary depending on the applications installed on
your Pen. Select an application to view the application
files in the Desktop Window.

The Help Menu
The Help Menu contains the following options:
 Help: Access the Desktop online help document.
 Communications Wizard: Run the
Communications Wizard to establish
communications between your Pen and the PC.
 Register at WizCom Site: Register your Pen on the
WizCom website.
 About: View the Desktop copyright and version
information.
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The Toolbar
The Desktop Toolbar is located beneath the Menu Bar and
allows quick access to some of the most-used Desktop
functions. To select a toolbar option, click on the icon.
To hide or show the toolbar, select Toolbar from the View
menu.

The Toolbar contains the following options:
New
Create a new file in the selected application.
Open
Open a file in the selected application.
Save As
Save the current file under a new name or in a
different format.
Print
Print the current file.
Pen Names
Add, rename or remove Pen Names.
Add/Remove Pen Components
Add or remove Pen components.
Turn Pen Communications Off/On
Toggle Pen communications off and on.
Current Pen Name
Shows the name of the Pen
currently selected on the
Desktop.
Help
Accesses the Desktop online help.
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Desktop Window
The Desktop Window is split into vertical panes. To resize or
hide a pane, drag the split bar between two panes to one
side.

Application Pane
The left pane, present at all times, is the Application Pane
and displays the icons of all the applications installed on the
Pen. Click on the application icon to view the files associated
with the application.

Files Pane

The Files Pane displays the list of files for the selected
application. Select a file name to view the contents of the
selected file in the right pane, the Current File Pane. This
Pane is only visible when viewing Notes and Tables files.

Current File Pane
Files can be created, opened and edited in this section. To
from the toolbar or Open from the File
open a file, select
menu and choose the file you wish to open. For applications
with a middle pane, click on a file from the Files Pane. Only
one file can be opened at a time.
Note: Any changes made to files are saved automatically.
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The WizCom Desktop Taskbar Icon
The Desktop icon
is located in the notification area of the
Windows taskbar. If you have set the Desktop to launch
upon startup, the icon will appear automatically each time
you start your computer. If not, the icon will appear only after
you launch the Desktop.
icon on
When the Desktop is open on screen, clicking the
the top right of the screen will not exit the application, but will
cause it to minimize to the taskbar.
The Desktop is still running in this state. Clicking on the icon
will cause a pop-up menu to appear with the following
options:

The Taskbar Menu contains the following options:

 Hide/Show Window: Minimize or maximize the
Desktop application.

 Turn Pen Communications On/Off: Activate or
deactivate Pen-PC Communications.

 File Transfer Settings: Modify the QuickLink

settings using the File Transfer Settings dialog box.

 Scan to PC Settings: Define the character to be

inserted after each line of text you scan using the Scan
to PC Settings dialog box.
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 Log: See the log of the last Pen-PC communication
activity.

 Help: Access this document.
 About: View the copyright and version information for
the Desktop application.

 Exit: Exit the Desktop application.

Changing the Desktop Interface
Language
The Desktop contains support for user interfaces languages
other than English.
To change the Desktop interface language:
1. Select Interface Language from the View menu on
the Menu Bar. The Interface Language dialog box
appears.
2. Select the interface language you want from the list and
click OK.
3. Restart the Desktop.
Note: Your Windows settings (non-unicode programs option)
must be configured to support the selected language. If your
Windows version doesn’t support the character set of the
selected language, you will not be able to view the character
set correctly.
Language settings can be accessed through the Windows
Control Panel Regional and Language Options setting
(name of setting menu varies depending on which operating
system you are running).

58

The WizCom Desktop

Pen-PC Communication Settings
There are four ways in which the Pen communicates with the
PC via the Desktop application:
 QuickLink (initiated by Pen)
 Scan to PC (initiated by Pen)
 Optimize Pen File System (initiated by Desktop)
 Launching the Add\Remove Pen Components
dialog (initiated by the Desktop)
When communicating with the PC, the Pen must be
connected to the PC using the cable provided with the Pen.

Communication Settings
The Communications Settings dialog box (accessed from
the Pen-PC Communications menu on the Menu Bar)
allows the following information to be modified:
 The type of communications.
 The communications port on the computer to which
the connection device is associated.
 The communications baud rate (the speed at which
the data is transmitted).
Communications settings must be defined correctly on both
the Pen and Desktop in order for the two to communicate.
See Establishing Pen-PC Communications on page 9 to
configure the correct communication settings for both the
Pen and PC.

Desktop Modes – Turn Pen
Communications Off/On
The Desktop application runs in two modes - online or
offline. The default mode is online.
Offline Mode
When the computer is offline, communications with the Pen
are disabled. The Desktop cannot detect communications
from, or initiate communications with the Pen. The Pen
Communications menu options are disabled.
To disable Pen communications, select Turn Pen
Communications Off from the Pen Communications
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menu on the Menu Bar, or deselect the
icon on the
Toolbar. The option toggles to Turn Pen Communications
On.
Select Turn Pen Communications On to re-enable Pen
communications.
Online Mode
When you are working online, communications with the Pen
are enabled. The Desktop occupies the communications port
on your computer and is in a state of readiness to receive
communications from the Pen. It detects QuickLink or Scan
to PC commands being sent from the Pen, and can also
initiate Desktop-controlled communications, such as
optimizing the Pen file system using the Pen's PCControlled Communication option.
Note: When Pen communications are enabled, the
communications port specified in the communications
settings on the Desktop is busy, and cannot be used for any
other purpose.

Optimize the Pen File System
When you delete data from your Pen (either manually or by
using the Flush option in the File Transfer Settings dialog
box), the area that was used by the data is not actually
deleted from the extension card memory. The Optimize
Pen File System option enables you to free up those areas
on the Pen’s extension card memory that are no longer
being used by application data.
To optimize your Pen's file system:
1. Turn your Pen on and select PC-Controlled
Communications from the Pen Main Menu.
2. Select Optimize Pen File System from the Pen
Communications menu on the Menu Bar of the
Desktop application. A progress bar appears on the
computer that displays the progress of the optimization
process.
 If communications between your Pen and PC fail,
an error message appears when you select
Optimize Pen File System. Try running the
Communications Wizard from the Help Menu
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on the Menu Bar to correct the communications
setup.
 If the Pen you have connected is not recognized by
the Desktop, you are prompted to use the current
Pen Name, choose an existing Pen Name or
create a new Pen Name.
3. When the process is complete, a success message will
appear.
Important: Do NOT abort the Optimize Pen File System
process before it is completed. Failure to complete the
process may result in the loss of all the Pen data.

Add/Remove Pen Components

The Add/Remove Pen Components menu is accessible
via either the Pen Communications menu on the Menu
Bar of the Desktop application, or by clicking
in the
Toolbar. The dialog can only be launched when the Pen is
connected to the PC and PC-Controlled Communications
has been selected on the Pen.
This dialog is for advanced users only and should not be
accessed unless directed to by Support personnel.

Managing Several Pens in the Desktop
You can use more than one Pen with the same Desktop
application. Each Pen is defined on the Desktop by a unique
Pen Name to make it recognizable by the software. The
Pen Names dialog box contains several options for
managing the Pens in the Desktop. Use it to add, rename or
remove a Pen or to set the current Pen.
Access the Pen Names dialog from the File menu on the
on the Toolbar. The default
Menu Bar or by clicking
Pen Name is "MyPen".

Adding, changing and deleting Pens



To add a Pen: Open the Pen Names menu and select
Add. Type in a name for Pen and click OK.
To change a Pen: Open the Pen Names menu and
select the Pen Name you want to change. Select
Rename, type the new name into the Rename box and
click OK.
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To delete a Pen: Open the Pen Names menu and
select the Pen Name you want to delete. Select
Remove, click Yes when the confirmation message
appears and click OK.

Set the Current Pen
You can change the current Pen at any time by using the
Current Pen drop-down list in the Toolbar.
Alternately, to set the current Pen: Open the Pen Names
menu and select the Pen Name that you want to set as the
current Pen. Select Set as Current and click OK.

Working with Files in the Desktop
Notes and Tables
To create new files: Click on the application icon and click
on the Toolbar. Type a name in the New File box and
click OK.
 In Notes: Add or delete paragraphs by right-clicking in
the Current File Pane and selecting the required
option from the menu.

 In Tables: Add or delete rows by right-clicking on the
row number and selecting the required option from the
menu. Add or delete columns by right-clicking on the
column letter and selecting the required option from the
menu.
To edit files: Select the file you want to edit from the Files
Pane. Double-click on the paragraph you wish to edit and a
blinking cursor will appear at the beginning of the paragraph
indicating that the text in the paragraph can be edited using
the regular Windows keyboard editing commands.
Note: All modifications made to files are automatically saved
by the Desktop.
To open an existing file or import a file: Clicking on the
application icon in the Application Pane and click
on
the Toolbar. Locate the file you wish to open and click
Open.
To save files with a different name or in a different
on the Toolbar. Choose the format, file
format: Click
name and location and click Save.
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To delete files: Right-click on the file you wish to delete in
the Files Pane and select Delete File from the pop-up
menu.

Address Book and Internet Links
To create new entries: Click on the application icon and
then double-click in the Current File Pane. Fill in the entry
details in the pop-up window and click Update.
To open an existing file or import a file: Click on the
application icon in the Application Pane and click
on
the Toolbar. Locate the file you wish to open and click
Open.
To edit entries: Double-click on the entry you want to edit,
change the details in the pop-up window and click Update.
To save files with a different name or in a different
on the Toolbar. Choose the format, file
format: Click
name and location and click Save.
To delete entries: Right-click on the entry you wish to delete
in the Current File Pane and select Delete from the popup menu.
Note: Only entries saved in the files "mainadd.qad" or
"mainlnk.qlk" will be synchronized with the Pen.
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Additional Information
Batteries
Your Pen comes with 2 AAA Alkaline batteries. If the
batteries are low, the "Replace Batteries" message appears
on the Pen. When the batteries are about to run out, the Pen
shuts down automatically. Many issues may occur on the
Pen due to low batteries. If you encounter strange behavior,
check the battery level in the Information menu and
replace batteries if relevant.

Safety Points (Batteries)
CAUTION: Risk of explosion if battery is replaced by an
incorrect type. Use AAA Alkaline batteries only.
 Always place 2 fresh batteries in the Pen. It is not
advisable to use the Pen with batteries that are not at
the same voltage level.
 Do not combine different types of batteries (e.g.
rechargeable and non-rechargeable).
 Dispose of used batteries according to the
manufacturer's instructions.

Pen Maintenance
Your Pen conforms to the highest standards of
craftsmanship and manufacture. To keep your product in
good condition, follow these guidelines:
 Store in protective case when not in use.
 Keep away from excessive moisture and temperature
extremes.
 Clean using a soft, damp cloth.
 Avoid exposing to direct sunlight for extended periods
of time.
CAUTION: To reduce the risk of electrical shock or damage
to the internal components, do not spray liquid directly on the
screen or allow excess liquid to drip inside your Pen.
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Troubleshooting
Problem: I have followed all the instructions for
establishing Pen-PC communications and my Pen will
still not communicate with my PC. What else can I do?
Solution:
1.
2.

Make sure you have new, fresh batteries in your Pen.
Make sure you are an administrator on your computer.
Sometimes installations will be unsuccessful if you try to
install new software n a computer where you do not
have full administrator rights.

3.

Unplug any devices that sync data between the device
and your PC, i.e. PDAs or digital cameras. If the icon for
the device appears in the notification area of the
windows taskbar (bottom right of the screen next to the
time display) right-click on the icon and exit the
application.
When you connect the USB cable to both the Pen and
PC, make sure the cable jack is pushed all the way into
the Pen and confirm that you hear the last little 'click'
when the cable is fully inserted.

4.

5.

If this doesn’t help, try inserting the USB cable into a
different port on the computer.

6.

If you are using a laptop and the baud rate in the device
manager is set to 115200, try changing the baud rate in
the Device Manager as follows:
a. On your computer go to Start/Settings/Control
Panel and select System.
b. Click on the Hardware tab and then click on the
Device Manager.
c. Scroll down to Ports (COM & LPT) and open the
drop-down list of ports.
d. Find the "Prolific USB-to-Serial Comm Port".
e. Double-click on the prolific driver and go to Port
Settings. Try changing the Port Settings only in
the Device Manager (not on the Desktop or Pen).
f. Try a few different settings. This should help.
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Problem: I have installed the USB driver but when I plug
the Prolific USB cable into my computer it is not
recognized. What could be the problem?
Solution:
There could be one of two problems: Either the USB cable
driver has not been installed correctly or you have a faulty
cable. To check this, do the following:
1. Make sure you are an administrator on your computer.
2. Unplug any devices that sync data between the device
and your PC, i.e. PDAs or digital cameras. If the icon for
the device appears in the notification area of the
windows taskbar (bottom right of the screen next to the
time display) right-click on the icon and exit the
application.
3. Run the USB cable installation from the website or
product installation software. If you have already tried to
install the USB driver you will receive several options.
Select the remove option. Once the driver has been
removed, restart your computer and reinstall the driver.
4. Connect the USB cable to both the Pen and PC. Make
sure the cable jack is pushed all the way into the Pen
and confirm that you hear the last little 'click' when the
cable is fully inserted.
5. The Windows “Add New Hardware Wizard” should
appear and the complete the driver installation.
6. On your PC go to Start/Settings/Control Panel and
select System. Click on the Hardware tab and then
click on Device Manager.
7. Find Ports (COM & LPT) and check that the "Prolific
USB to Serial Comm Port" is listed.

If you can’t see the driver in the Ports list, try the following:
1. Try to reinstall the driver
2. Try using a different USB port. Sometimes the cable will
be recognized when plugged into one USB port and
might not be recognized on another.
If you follow the above process and the cable is still not
detected, contact support for a replacement cable.
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Problem: I receive the following error when trying to
install items from the website: “Setup.exe has
encountered a problem and needs to close”. What
should I do?
Solution:
The Setup.exe error is an error generated by Microsoft. It
occurs sporadically and is usually resolved by restarting your
computer.
It can also be caused by the following:
1. The Desktop application running at the same time as
the installation.
2. Trying to install applications or dictionaries using a
computer where you don’t have administrator rights.
3. Another program running on your PC which is
interfering with the installation.
Please try the following:
1. Restart your computer.
2. Make sure that you are administrator on the computer
you are using.
3. Close any programs that may be running, especially
any devices that sync data between the device and your
computer, such as a PDA or digital camera.
This may also include closing programs such as printer
software and anti-virus software. You can see which
programs are currently running by looking in the
notification area of the windows taskbar (the bottom
right of your PC screen, next to the clock).

The notification area of the taskbar
4. Replace the batteries in the Pen with new, fresh
batteries.
5. Try inserting the USB cable into a different port on the
computer.
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Problem: I receive the following message when I turn my
Pen on: "Device is uncalibrated. Please return to
Vendor". What should I do?
Solution:
Try inserting new batteries into the Pen. This should solve
the problem. If the message still appears, your Pen will need
to be sent to our offices for calibration. Please contact
support in order to determine where to send your product.
Please include your name and location.
Calibrating the Pen is free. You will only need to pay
shipping costs. If, when the Pen is being checked, we
discover other problems that are not related to calibration,
you will be contacted prior to any work being done, to check
if you have a valid warranty and if not, whether you agree to
pay the extra repair charges.
Problem: I installed a specific dictionary or interface
language on my Pen but when I turned it on today, the
dictionary or interface language had disappeared! What
can I do to get it back?
Solution:
The extension card at the back of your Pen may not be
inserted properly.
Please try the following:
 Open the battery compartment.
 Remove the extension card from its slot above the
batteries and blow on it and into the extension card
compartment to remove any dust particles that may
have accumulated.
 Replace the extension card firmly into the slot.

This should restore the components to the Pen.
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Problem: I receive an "Out of memory" message on my
Pen. What should I do?
Solution:
If you receive this message, it most likely means that the
extension card at the back of your Pen is loose, not that you
have no memory left in your Pen.
All you have to do to fix this is open the back of the Pen
(where you inserted the batteries) with your fingernail and
press down firmly on the extension card with your finger.
If this does not fix the problem, open the battery
compartment. Remove the extension card from its slot above
the batteries and blow on it and into the extension card
compartment to remove any dust particles that may have
accumulated. Replace the extension card firmly into the slot.
This should solve the problem.
Problem: I’ve changed my Pen user interface to another
language and now I don’t know how to change it back to
English!
Solution:
Do the following:
1. From the Pen Main Menu scroll down until you see
and press ENT.
and press ENT.
2. Scroll down until you see
3. Scroll up or down using
or
until you see the word
English on the screen and press ENT.
This should return the Pen to the English interface.
Problem: My Pen will not turn on. What should I do?
Solution:
If your pen does not seem to turn on when you press the
power key, or if it seems to show a blank gray screen, make
sure the Pen is off and do the following:
 Open the battery compartment and insert new AAA
batteries.
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 Remove the extension card from its slot above the
batteries and blow on it and into the extension card
compartment to remove any dust particles that may
have accumulated.
 Replace the extension card firmly into the slot. Place
the flash card firmly back in place.
Close the battery compartment.
 Press the ESC button – and hold it down for 3-4
seconds – while pressing the power ON button.
Problem: The message “Loading” appears on the Pen’s
display when it is turned on. The Pen then shuts itself
off. How can I solve this?
Solution:
Hold down the ESC button for a few seconds and press the
power key. The Pen should turn on and display the Main
Menu.
To prevent this from recurring:
1. If you have any large Notes files stored on the Pen,
transfer them to your computer and flush them from the
Pen.
2. If the auto shut-off time selected on your Pen is fairly
short, reset it to a longer time.
3. Avoid creating large Notes files - store the data in a
number of smaller files instead.
Problem: The Pen’s wheels are squeaky. How do I solve
this?
Solution:
The wheels should not squeak, and they really do not tend to.
If you find that the Pen wheels squeak even slightly, run the
tip of the Pen back and forth on paper with just a bit of
pressure to eliminate the noise, or use the edge of a Penciltip to cause a tiny amount of graphite to fall between the
wheels and the tip which will lubricate the axle.
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Product Specification
Feature
Display Information
Keypad
CPU
Memory
 RAM
 ROM
 External memory
card
Communications
Optical Scanner

Description
Resolution: 122 x 32 pixels
Size: 61mm x 20mm / 2.4” x .8”
Push Buttons Power/ESC/ENT/Up/Down/Left/
Right)
ARM 7 TDMI
192KB
8 MB
4MB, 6MB or 8MB

USB Cable
 128 pixels linear array image
sensor
 400 DPI resolution
Power
2 x 1.5V AAA Alkaline batteries
Size
L x W x H:
163 mm x 38 mm x 23 mm
(6.4” x 1.5” x 1”)
Weight
90 grams (3 oz.) without batteries
+/- flash memory card)
Safety
 CE
 RoHS
 UL
 FCC class B
Operating Temperature 0°C - 40°C
Range
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Copyrights and Trademarks
© 2010 WizCom Technologies Ltd. All rights reserved.
WizCom Technologies Ltd. uses the Ligature OCR-on-aChip copyright
© 1995-2010, Ligature Compression Technology copyright ©
1996-2010, and Ligature reverse inflection and derivation
technology copyright © 1997-2010 under license from
Ligature Ltd. All rights reserved.
WizCom InfoScan™, QuickLink-Pen®, Quicktionary®,
Readingpen®, WizCom SuperPen™, WizCom and Pen
design are trademarks or registered trademarks of WizCom
Technologies Ltd. All rights reserved.
All other brands and product names appearing here are
registered trademarks or trademarks of their respective
owners.

Worldwide Limited Warranty
WizCom Technologies Ltd. (hereinafter - "WizCom")
warrants the initial purchaser (hereinafter - "PURCHASER")
of each of the products bearing the trade names or
trademarks Quicktionary, ReadingPen, SuperPen, InfoScan,
QuickLink or MEK (hereinafter - "PRODUCT") sold by
WizCom (including sale through WizCom's Web Site) or
WizCom's authorized local retail dealer (hereinafter "AUTHORIZED RETAILER") as follows: WizCom warrants
that your PRODUCT, under normal use, will be free of
defects in materials and workmanship for a period of : two (2)
years in EU countries and one (1) year for the rest of the
world from the date of original purchase from WizCom or
from WizCom's AUTHORIZED RETAILER along with the
original purchase receipt.
This limited warranty extends only to the original Purchaser
of the PRODUCT and is not assignable or transferable to
any subsequent purchaser/end-user.
WizCom's sole obligation, and Purchaser exclusive remedy,
under this express warranty, in lieu of all other warranties
express or implied by law or otherwise, shall be, at
WizCom's option and expense, to repair or replace either
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with new parts or used parts, without charge, PRODUCTS
that are found to be defective and malfunctioning during
normal usage and returned within the warranty period,
provided that: (i) The PRODUCT has not been damaged or
subjected to mishandling, improper storage, misuse, neglect,
abuse, accident, alteration, abnormal operation or conditions,
operation in an unsuitable environment or in a manner for
which it is not intended, unauthorized repair, unauthorized
modifications, or other acts which are not the fault of
WizCom. (ii) The PRODUCT has not been damaged from
external causes such as fire, flooding, sand, dirt, storm or
any other damage from weather conditions, an Act of God,
theft, or battery leakage, blown fuse, or improper use of any
electrical source, damage caused by computer or internet
viruses, bugs, worms, Trojan Horses, cancelbots or damage
caused by the connection to other products not
recommended for interconnection by WizCom.
(iii) No one other than an authorized WizCom representative
opens the casing of the PRODUCT.
(iv) WizCom has been advised in writing by the
PURCHASER of the alleged defect or malfunction of the
Product within fourteen (14) days after the expiration of the
applicable limited warranty period.
(v) This limited warranty does not cover physical damage to
the surface of the product, including breakage, cracks or
scratches on the LCD screen or outside casing.
(vi) The liability under this warranty is limited to the actual
cash value of the PRODUCT, determined by the price paid
by the Consumer for the Product less a reasonable amount
for usage.
Repair or replacement of the PRODUCT shall not extend the
original warranty period.
PURCHASER will be charged for all PRODUCT repairs for
damage or failure not covered by this limited warranty.
Return of the PRODUCT for repair or replacement under this
warranty, must be made to PURCHASER'S local dealer and
must be accompanied by proof of date of purchase,
identification of the PRODUCT by model
number and serial number and complete description of the
problem.
WizCom makes no warranty or representation that the
PRODUCT will meet the PURCHASER'S requirements or
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will work in combination with any hardware or software
products provided by third parties, that the
operation of the PRODUCT will be uninterrupted or error free,
or that all defects in the PRODUCT will be corrected.
EXCEPT AS EXPRESSLY SET FORTH IN THIS
WARRANTY, WIZCOM MAKES NO OTHER WARRANTIES
EXPRESSED OR IMPLIED, AND TO THE FULLEST
EXTENT PERMITTED BY LAW, WIZCOM DISCLAIMS ALL
OTHER WARRANTIES EXPRESSED OR IMPLIED,
INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR
A PARTICULAR PURPOSE OR USE.
In no event shall WizCom, its agents, officers or employees
be liable for any damages whatsoever, including (without
limitation) special, direct or indirect, punitive, consequential
or incidental damages, including, without
limitation, damages resulting from use of or reliance on the
products and/or services and/or advertisements regarding
the PRODUCT, loss of revenues, loss of profit, business
interruption, loss of information or costs
of replacement goods, loss of use of the product or any
associated equipment, cost of capital, loss of enjoyment of
the PRODUCT, arising from claims of third parties, including
customers or arising from breach of
the warranty, breach of contract, negligence, strict tort, or
any other legal or equitable theory without limitation.
WizCom reserves its right to make technical alterations to
the PRODUCT and such alterations shall not be considered
as breach of warranty.
WizCom shall not be liable for any delays or defaults
hereunder by reason of fire, floods, acts of God, labor
troubles, accidents to machinery, delays of carriers or
suppliers, inability of suppliers to supply,
the impositions of priorities, restrictions or other acts of
government, or other causes beyond its reasonable control.
The agents, dealers and employees of WizCom are not
authorized to make modifications to the warranty, or
additional warranties that are binding on WizCom.
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